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l. VINCILAB AT A GLANCE

1. Introduction

VincilLab is a modern and advanced mobile graphic data acquisition system, which can
be used in a variety of ways, standalone and with a computer and tablet, in the
classroom and in the field. It is a handheld Linux device equipped with two processors:
a main processor to control the device’s operating system and screen, and a
measurement processor to control the measurement and control processes. It has 8 GB
of internal memory 5.5 GB of which is available for user files.

VinciLlab has a 5” capacitive color touch screen that provides a high-resolution display
(800 x 480 pixels) offering easy control of the device. For wireless connectivity VinciLab
is equipped with Wi-Fi and Bluetooth. The dedicated desktop applications, pre-installed
on VinciLab, offer tools for setting up the device, setting up wireless connections,
managing user files, browsing the web, watching video files, playing audio files, etc.

For connecting sensors VinciLab has four analog BT inputs, which allow very fast data
collection up to 1000000 samples per second, and two digital BT inputs for Motion
Detectors. It also has built-in a 3-axis accelerometer and a microphone. Additionally
VinciLab can output DC and AC voltage signals between -5 V and 5 V via the 3.5 mm
audio connector™.

The powerful Coach Application, pre-installed on VinciLab, offers live sensor data
displays, real-time graphing, tools for data processing and possibilities to create new or
open ready-to-go Coach activities enriched with texts, images and web-pages.

VincilLab can also be used as a lab interface connected (via USB or Wi-Fi) to computers
(Mac and Windows), tablets (iPad, Android) and Chromebooks. Coach 7 and Coach 7 Lite
programs and apps support such measurements.

By using wireless connectivity and the VNC protocol the Vinci-Lab’s screen can be
remotely viewed and controlled from any computer or mobile device connected to the
same network. VinciLab is delivered with:

* USB cable for connecting to the USB port or USB power adapter,

* USB power adapter for powering and charging,

* User’s Quick Start Guide and User’s Guide.

! Not present on VincilLabs purchased before February 2019
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2. VinciLab overview

L
g i

Internal Microphone Capacitive Color Touch Screen
for recording sound signals for viewing and controlling

Power Button
for turning VinciLab On or Off and for turning the screen On when it is timeout

Digital Inputs D1, D2 Analog Inputs A1, A2, A3, A4
for connecting digital for connecting
Motion Detectors analog sensors
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USB Port Audio Out Port
for connecting any USB peripherals like a mouse, output for AC and DC voltage signals,
keyboard, USB flash drive, USB hub, etc. for connecting to a power amplifier

Mini USB Port .
for connecting a USB cable for charging Audio In Pc.>rt
or for communication with computer for connecting

an external microphone
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Battery Compartment
for the internal, lithium-ion rechargeable
battery (supplied with VincilLab)

Speaker
for playing audio

" For VinciLab’s purchased starting from February 2019, in the VinciLab’s sold before the Audio Out Port (green
connector) was used for connecting headphones or an external speaker.
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Il. GETTING STARTED

1. Turning VinciLab On and Off

To turn Vincilab On SETE ucv e @ /@"’ 5 ©~ 7=

° Press the Power Button once. GOECH! )AJ/ Fllzs SELLINGS] SOTINELL DYIS]
* While VinciLab is booting the @ @ ) -

message ‘Vincilab is starting. Please | .. s iges g e ST
wait.” is displayed.

* Wait until the device finishes its
booting procedure and displays its 7
starting Home Screen as shown on

the image. )~

Note:
* The minimum battery level to start VinciLab is 1%.

To turn VinciLab Off

* Tap @ Shut Down in the status bar.
* On the new screen tap:

@ Shut Down to shut down VincilLab.

E Reboot to restart VincilLab.

Ej Screen Off to turn the screen off.
Pressing the Power button turns the screen on again.

kj Cancel to cancel the operation and return to the Home Screen.

Note:

* Holding the Power button for about 8 seconds causes VinciLab to shut down. Use this
possibility only in case of emergency when your VinciLab does not respond anymore.

2. Powering VinciLab

An internal rechargeable battery (Li-Poly 3.7 V, 4000 mAh, located in the back
compartment), powers VinciLab. The battery icon on the status bar of the Home Screen
indicates the current power level.

VincilLab is delivered with its battery partially charged. The device will work as long as
the battery provides power or it is powered via the power adapter. Before the battery
becomes too low for operating the device a warning will appear on the screen. If you
continue working without charging, the device will shut down. A fully discharged battery
requires up to 8 hours of charge time.
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To charge battery

Only use the USB cable and USB power adapter delivered with your VincilLab.

* Connect the USB cable to the mini USB port of VinciLab.

* Connect the other end of the USB cable to the USB power adapter.

* Plug the USB power adapter into a standard power outlet.

-or-

* Connect the USB cable to the mini USB port of VinciLab.

* Connect the other end of the USB cable into a USB port of your computer. Notice,
that the efficiency of charging via a USB port, is limited by the maximal current
provided by a USB socket (500 mA for USB 2.0 and 800 mA for USB 3.0).

Battery life will depend on the screen brightness and on the sensors and features used,
but typically you can expect to use VinciLab at least 4 hours without recharging it. To
save power dim the brightness of the screen or turn off the screen when you do not
need it. See also /ll. VinciLab Applications, 3. Settings.

The long-time life of the battery is more than 300 full (0 to 100%) charging cycles. If
charging cycle is not full e.g. 30% to 60% it will last more charging cycles. Exposure to
temperature over 35°C will significantly reduce battery life. A replacement battery can
be ordered separately (CMA art. code 001bat).

Notes:

* VinciLab can be used while the battery is being charged by the power adapter.

* VinciLab typically consumes about 450 mA. If you run some videos, set the screen brightness
to the maximum level, do a lot of data transferring via Wi-Fi, connect many sensors and
external USB devices then power consumption will be much higher.

*  When the USB port does not provide enough power, VinciLab will not be charged or charging
will be significantly slower.

* On most computers USB ports do not provide enough power for simultaneous operating of
VinciLab and charging its battery.

*  When VinciLab discharges fully it will not turn on until a minimum charge of 1% is reached.

3. Home Screen

The Home Screen is the starting point for using your VinciLab and provides shortcuts to
applications. The status bar is always present at the bottom of the Home screen and
offers information about the device’s current status.

3.1. Applications

The following applications are available on VincilLab:

[/@ Coach: Handling sensors, collecting, graphing and processing data.
.

@ My Files: Managing user and Coach files on Vincilab.
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Settings: Configuring the device to your preferences.

&

N
/

Connections: Configuring the wireless connections.
Web Browser: Accessing the Internet.

Images: Browsing and displaying images.

Media Player: Playing audio and video files.

Calculator: Performing simple mathematical calculations.

S ©

* Tap an application’s icon to launch the application.

* Tap Back to return to the previous screen or option.

* Tap -~ Home to display the Home Screen.

Detailed descriptions of applications are given in /ll. VinciLab Applications.

3.2. Status bar

The icons in the status bar at the bottom of the Home screen give information about
VincilLab:

Icon Name Operation
C Coach Appears when Coach is running
NS\ . .
..... active Tap to switch back to Coach
Q}I‘,)@x Volume Shows the status of Volume, On or Mute
' Tap the icon to change the Volume level
o Wi-Fi Shows the Wi-Fi connection
v ' Blue: There is a Wi-Fi connection
Gray: No Wi-Fi connection
Tap the icon to change the Wi-Fi configuration
W O Battery Shows the battery level or charging status
' ) Tap the icon to check the battery status
13.40 Time Shows the current time
Tap the icon to change the time settings
. USB device Appears when a USB device is detected
'&\) Tap the icon to safely remove the connected USB device
* Bluetooth Appears when Bluetooth is turned on
active White icon: Bluetooth is on and paired with a device
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3.3. Navigation

WARNING! Touch screen best responds to a light tap from the pad of your finger. Using
excessive force or a metallic object when pressing the touch screen may damage the
glass surface and void the warranty.

Tap

Tap items to select or launch them. For example tap an item to select it, tap an
application’s icon to launch the application or tap the on-screen keyboard to enter text
or numbers.

Flick or drag

Flick or slide your finger vertically or horizontally across the screen. For example browse
through images or scroll a long screen.

Pinch ‘

Using two fingers, such as your index finger and

thumb, to make a pinch motion on the screen. The ‘ OK
fingers should be located as shown on the picture.

For example pinch in to zoom in on images and

pinch out to zoom out on images. ‘

NOT OK
Touch, hold and release ‘

Activate onscreen items at the moment of releasing.
For example used in Coach, tap a sensor digital display, hold and release to open its
menu.

4. Sensor inputs

4.1 Analog sensor inputs

VincilLab has four analog BT (right-handed) sensor inputs A1, A2, A3, A4 with a maximum
sampling rate of 1 MHz (four inputs simultaneously). CMA BT sensors® (with exception
of the CMA digital Motion Detector) can be directly connected to the analog sensor
inputs.

All analog inputs can be (simultaneously) used as counter inputs. Sensors such as the
CMA Photogate (art. code 0662i or BT633i) or CMA Radiation sensor (art. code 0666i or
BT70i) are by default defined as counters. Other analog sensors can be used as counters
after defining the counter conversion settings in Coach e.g. defining a heartbeat sensor
to count heartbeats.

2 Analog Vernier BT sensors can be directly connected to VinciLab as well. Older (4-mm) versions of CMA sensors
can be connected via a 4mm to BT adapter (art. code 0519).
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4.2. Digital sensor inputs

VinciLlab has two digital BT (left-hand) sensor inputs D1 and D2. The CMA BT digital
Motion Detectors can be directly connected to these sensor inputs.

4.3. Sensor detection

VincilLab supports sensor recognition and tries to identify sensors connected to inputs.

* When Coach identifies the connected sensor then its name is automatically
displayed in the Activity Screen tree and its digital display appears on the Sensors
Screen. When the sensor is then disconnected its name and digital display disappear
automatically.

* When Coach does not identify the connected sensor then its name and digital
display does not appear. This happens for some older CMA sensors or sensors
connected via the CMA 4-mm to BT adapter art. code 0519. The user has to manually
choose and select the correct sensor from Coach Sensor Library. This is done via the
option Sensor Settings available in the Tool menu of the Sensors Screen. When the
sensor is disconnected then Coach keeps displaying the sensor name and its digital
display. The sensor can be removed by selecting the option None or selecting another
sensor from the Sensor Library.

* When a predefined sensor is already set up in an Activity/Result and Coach:

- identifies the connected sensor as a different sensor then the sensor name
becomes red, tap Exchange to change the sensor to the connected one.

- does not identify it then its name remains grey, tap Confirm to accept the pre-
defined sensor or tap Clear to remove the connection.

See also ‘IV. Coach Application, 5. Sensors Screens’.

5. Built-in sensors

Vincilab is equipped with two internal sensors:

* A Microphone, which measures sound waveforms. This sensor can be used as:

- asingle sensor, this is possible only when working with a Coach Result for Sound
only, or a Coach Activity for the Internal microphone.

- in combination with other sensors, the sound sensor will be then connected for
measurements via input A2. To make the sensor ready for measurement open
the Sensor Settings dialog and tap the Enabled Internal sensor button. When the
sensor is enabled no other measurements can be done via input A2 even if there
is a sensor connected to this input.

If an external microphone is connected via Audio In port then the internal

microphone is disconnected and the external microphone is used instead.

e A 3-axis Accelerometer, which measures acceleration in 3 ranges: = 20 m/s’,
+ 40 m/s> and = 80 m/s” in the x, y and z directions. This sensor can be used in
combination with other external sensors.

To make the sensor ready for measurement tap X, Y or Z tab in the Sensor Settings

and tap the checkbox Enabled. The X, Y, Z tabs are used for the acceleration

components respectively in x, y and z direction.

See also ‘IV. Coach Application, 5.1. Sensor Settings’.
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For the directions of x, y and z axes of Gravity
the accelerometer see the image.
Holding the VinciLab in the shown
position should give the following
values of the component accelerations:

x-component = 0 m/s’

y-component = 0 m/s’

z-component = -9.81 m/s’.

6. Signal generator

Via the 3.5 mm Audio Out port VinciLab outputs DC and AC voltage signals between -5V
and 5V. This functionality is present only on VinciLabs sold starting from February 2019
(the Audio Out port of these models has a blue connector). There are two channels
available’.

7. Using VinciLab with computers and tablets

VincilLab can be used with computers:

1. As a lab interface to collect data, the Coach 7 or Coach 7 Lite program running on a
MAC or Windows computer controls the data collection via USB or Wi-Fi.

2. To transfer files between the ‘My Files’ folder on VinciLab and the computer (only via
USB).

3. To display the VinciLab’s screen in a VNC Viewer Program (using VNC protocol via
Wi-Fi or USB).

VinciLab can be used with tablets:

1. As alab interface to collect data, the Coach 7 or Coach 7 Lite app running on an iPad
(only via Wi-Fi), an Android Tablet (via USB and Wi-Fi) and a Chromebook (only via
Wi-Fi) controls the data collection.

2. To display the VinciLab’s screen in a VNC Viewer Program (using VNC protocol via
Wi-Fi).

For more detailed description see ‘V. Using VincilLab with a computer and a tablet’.

* This functionality will be supported starting from March 2020.
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l1l. VINCILAB APPLICATIONS
Read this chapter to learn how to use VincilLab’s applications.

1. Coach

Use Coach to create new Results, open
pre-defined  Activities, to  setup
experiments, collect data, display and
process the collected data, save the
results.

* To start tap Luu Coach.

The detailed description of Coach is
given in IV. Coach Application.

2. My Files

Use My Files to manage your files on [F{EIS

Vincilab, to copy and delete folders and | ] )y Fiies o
files, to send files by e-mail. 1 |J coach

* Tostart tap @ My Files. L i it

The My Files Screen displays folders and
files located in the My Files folder. This
folder is meant to store user’s files.

Note that in the folder Coach >

DataRecovery you can find backups of
measurements. This allows you to find the measurement results of long measurements
stopped unexpectedly.

To browse through folders

* Tap \U or the name of the folder you want to open.

* Tap \w to return to the previous folder.

To create a new folder

* Browse to a location where you want to create a new folder.
* Tap \M to add a folder.

* Typein a name and confirm with @

To open a file
* Browse to the file you want to open.

* Tapitsicon e.g. or its file name. The associated application will open, e.g. Media
Player if you tap an audio file.
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To select folders/files F“es 3

. Tatho select desired folders/files. [ {_J /my Files/coach ,@3
* Check marks appear in the check [ [ ] DataRecovery

boxes and additional icons appear in [@] Evaporation of alcohols.cmr
the bottom bar. ] @ Newton's law of cooling.cmr
4 @ Result_20181001.cmr
To copy selected items I @ sound.cmr
D sound.txt

* First select items as described above. '
+ Tap P to copy the selected items. Rl N I

The clipboard icon changes into QJ to indicate that something is placed on the
clipboard.

* Browse to the location where you want to copy the items and tap _[_]J to paste the
items in the selected location.

To move selected items
* First select items as described above.

* Tap ‘3’" to cut the selected items.

* Browse to the location where you want to move the selected items and tap _U_J to
paste the items in the selected location.

To delete selected items
* First select items as described above.

* Tap [E! to delete the selected items and confirm with @

To work with a USB memory stick
* Insert your USB stick into the USB port of VincilLab.

* Theicon 9y appears on the bottom bar when the device is detected.
* In My Files the USB folder is added. Now you can copy or move files between
VinciLab and the USB memory stick.

* Taptheicon 4 and confirm with @ Remove the stick.

000 VinciLab:0 - VNC Viewer

. . My Files > Mail
To e-mail selected items

To: (info@cma-science.nl ]
* First select items as described above. subject: ~ [my data )
J . Attachments: @ Evaporation of alcohols.cmr (66.6KB)

* Tap to open a mail screen. The yecage:

selected items will be added as

attachments.
* In the To field type in an e-mail

address.
* Fill in Subject and Message. Q0

e Confirm with @

Vincilab User’s Guide | 15



3. Settings

Use the Settings application to configure _

your Vincilab. DEVICE |

Al
&) sound
* Tostarttap %?} Settings.

* Scroll down to see all options.

Volume L ®)

Enable system sounds L%
3.1. Device Settings B Display
Device settings include Sound and Brightness
Display settings and Battery phenenbaenypewes e 9

information.

To set the sound level and enable system sounds

* Tap and drag the Volume slider to set the volume level.
* To play system sounds check Enable system sounds.

To save power

* Lower the brightness of the screen. Tap and drag the sliders to set the screen
brightness when on battery power and when on external power. These settings
become effective after leaving Settings.

* Select a screen timeout - the length of time delay between the last key press or

screen touch and the automatic screen timeout. Tap [» and select the desired time

interval.

Note:
* To reactivate the screen press VinciLab’s Power button.

To change the wallpaper of the Home Screen

)
.-/) .

* Tap a Wallpaper thumbnail or
* The Wallpaper Screen appears. Select a new image.

* Tap  toaccept and return to the Settings Screen.

Battery displays the battery level and estimated working time.

3.2. System Settings

System settings include Language, Time and Date settings, Home-page setting, Software
update and Device information.

To set VinciLab’s language

y .

* Tap Language or
* The Language Screen appears. Select the desired language, a check mark appears in
the check box.

* Tap  toaccept and return to the Settings Screen.
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Note:

* This language setting is only for the Desktop Applications, not for Coach. Language of Coach
has to be set via the option Switch Language in the Main Tool menu of Coach.

To set the date and time
* Enter the current date/time by tapping 4. and ¥.

To set the homepage

e Tap Homepage or [ .
* Type in a webpage address you like to use as the Homepage for VinciLab Web
Browser.

e Confirm with @

To update VincilLab system and its applications
* Connect to a Wi-Fi network. See ‘lll. VinciLab Applications, 4.1. Wi-Fi’.

e Tap " software Update or ) .
The Software Update screen appears

and automatically lists all installed

software packages (grey) and new Packages:

available updates (black). [] Coach 6.54.011 1 [Installed: 6.54.007 1] I
* Tap an update package to select it or Coach Projects En 1.0.000 3 [Installed]

tap gto select all available new Coach Projects NI 1.0.000 1 [Installed]

packages.

[ | Desktop 1.0.5 1 [Installed: 1.0.2 1]

e

Tap " tostart the update. Firmware 1.0.0 29 [Installed]

* The selected updates will be _
downloaded and installed on the

device. The progress of this process is displayed on the Screen. Wait until the
message Update is finished appears, it may take a few minutes.

* Tap = toreturn to the Settings Screen.
Reboot your device.

To view Information about VincilLab

i
* Tap ~ About.
* On the About Screen the information about VincilLab is displayed.

* Tap = toreturn to the Settings Screen.
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4. Connections

Use the Connections application to connect Vincilab to the Internet and to other
wireless devices.

* Tostarttap & Connections. T

= Wi-Fi Ld_)i
4.1. Wi-Fi IP: 10.0.1.19
Available Networks:
Wi-Fi is a wireless networking 9=
Thomson6F6B1A .

technology that provides access to local
area networks. Vincilab supports the v cwva
802.11 /b/g/n Wi-Fi protocol.

(W
o))

D))

KPN
To turn Wi-Fi On and Off

* To turn the Wi-Fi services on drag the Wi-Fi slider to the position ON.

* VincilLab automatically scans for available Wi-Fi connections. The Wi-Fi icon at the
right shows the signal strength; the more bars are displayed, the stronger the signal
is.

* When the scan is completed, tap a Wi-Fi network to connect to. If the Wi-Fi network
is open, you will be connected automatically. If the Wi-Fi network is secured, enter
the password.

* If you want to manually join a network (connect to a closed network) select Join
other, and enter the network name, security type and password, and confirm with

Q.

* When VincilLab is successfully connected to the selected network the assigned to
VinciLab IP address appears in the Connections screen.
* To turn the Wi-Fi services off drag the Wi-Fi slider to the position OFF.

Note:
* VinciLab remembers the preferred network and its settings.

4.2. Data Share

Turning Data Share on will start a Virtual Network Computing (VNC) server on VincilLab.
VNC is a technology for remote desktop sharing; it enables the screen display of a device
to be remotely viewed and controlled over a network connection.* To allow this a VNC
viewer program needs to be installed on the controlling device (client) and remote
connection has to be established between the two devices. Such VNC viewer programs
are freely available for all platforms.

See also V. Using VinciLab with a computer and a tablet, 5. Displaying VincilLab’s screen
on a computer or a mobile device.

*VNC works in a similar way to Windows' Remote Desktop but allows connections to Linux operated machines.
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To turn Data Share On and Off

* Make sure that VincilLab is connected to a network.

* To allow data sharing drag the Data Share slider to the position ON.

* VinciLab shows that VNC is running and displays its IP address.

* Now you can use another device connected to the same network to view and control
your VincilLab. To do so, start a VNC Viewer installed on such device and connect to
VincilLab by providing its IP address.

* To stop the data sharing drag the Data Share slider to the position OFF.

Note:
* VinciLab remembers the Data Share slider setting.

4.3. Bluetooth

Bluetooth is a short-range wireless communications technology for exchanging
information over a distance at most 100 m. VincilLab supports Bluetooth® 4.1.

To turn Bluetooth On or Off

* To turn Bluetooth On drag the Bluetooth slider to the position ON.

* VinciLab automatically searches for Bluetooth devices nearby.

* From the list of scanned devices, tap the target device, then follow the prompts to
complete the pairing.

* |If the target device requires a PIN, enter a PIN for the target device and confirm with

Q.

* When paired, the Bluetooth icon appears in the System Bar.
* To turn Bluetooth off drag the Bluetooth slider to the position OFF.

Bluetooth communication can be used e.g. to connect a wireless Bluetooth keyboard or
mouse to Vincilab.

5. Web Browser
Use the Web Browser application to access the Internet.
* Tostarttap @ Web Browser.

Vincilab is equipped with a very simple HTML Browser.

To type a URL or other text

* Tap the URL field at the top of the screen or a text field to display the virtual
QWERTY keyboard to enter text.
e Tap Enter to accept the text.

* Tap =5 Close to hide the virtual keyboard.
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To navigate

* Tap @ Back in the window header to return to the previous page.
* Tap @ Forward to go forward to a recent page.

* Tap @ Refresh to refresh the connection.

* Tap and drag your finger on the screen to navigate pages, and to reposition pages
within the screen.
* Tap a hyperlink to follow the link.

To zoom
* Use two fingers, such as your index finger and thumb, to make a pinch motion on the
screen.

See also ‘Il. Getting Started, 3.3. Navigation’.

6. Images

Use the Images application to view (S )

images stored on your device in the -
folder My Files/Media/Images. -
electromyogram formants ree fall

E  p

The Images Screen d|sp|ays the heart-rate induction motion pressure
thumbnails of images located in My ‘& " ;/L
F”eS/M Edla/lmagES- rad]atmn sound speed of sound temperature

* Tostarttap @ Images.

g =
e W

IR

_— 4

To browse and display an image

* Tap a desired image thumbnail to select it.

* The selected image is displayed in its original size or zoomed to fit the screen.
* Tap and slide across the screen to move the image.

* Pinchinto zoom in and pinch out to zoom out the image.

* Swipe left or right to browse through images.

7. Media Player

Use the Media Player application to play

music and video files stored on VincilLab
in the folder My Files/Media
/Audio and MyFiles/Media/Video.

* Tostarttap . Media Player.

To play a media file

B Rl [ ——|

to begin playback.
* During playback, use the media controls:
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(]

Stop to stop playback.
Play to resume playback.

“ Pause to pause playback

@C Mute to mute the sound.
* Tap and drag the Volume slider to set the playback sound volume.

8. Calculator

Use the Calculator application to |

) e | o’y
perform simple mathematical

MC 7
* Tostart tap = “ Calculator.
L e I
R | I | R | N [ |
TR | R | W | W | W | W
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IV. THE COACH APPLICATION

Read this chapter to learn how to work & 9 [v]
with the Coach Application on VincilLab.

To start Coach

* Tap Luw Coach on the Home Screen.
* The Main Screen of Coach opens.

1. Main Screen

Coach Application () 16:38

The Main Screen displays the Coach
Title image, the Toolbar and the bottom bar. The Toolbar offers the following icons:

Tap this icon to:

Exit Coach

Open a Coach Activity or Result

Create a new Coach Result

Display the Main Screen Tool menu

Exit Coach

x| [€] [*] [B[2] 8

MAIN SCREEN TooL MENU

- New - to create a new Result.

- New (Sound Only) - to create a new Result for collecting data via the internal
sound sensor.

- Open ... - to open a Coach Activity/Result (*.cma/*.cmr).

- Open CMA Project... - to open a CMA Coach Activity/Result (*.cma/*.cmr).

- Switch Language - to change the language of Coach User Interface. To reflect this
language setting first close Coach and open it again.

- Quit Coach - to quit Coach Application.

Across the bottom bar the Coach version number, the Home Screen icon and time
information are shown.

7\
e Tap - to go to the Home Screen of your VincilLab, tap 2 to switch back to Coach.

2. Coach Activities and Results

Coach works with Activities (*.cma files) and Results (*.cmr files). Coach Activities and
Results contain experiment settings, diagrams and tables, data, texts, images, web
pages, and student notes.

Coach Activities are Coach documents created in the Author mode of the Coach 7
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program (such activities have to be saved via the option File > Save for
Molab/VinciLab). Student users can open such Activities in the Coach application but
cannot overwrite them. Instead Student users save the results of their work in Coach
Results. Exemplary CMA Coach Activities and Results are stored in the CMA Coach
Projects folder. This folder can be opened directly via the menu option Open CMA
Project available in the Main and Activity Screen Tool menus. Coach Activities and
Results can be stored in the VincilLab’s user folder My Files > Coach.

To open an Activity/Result (*.cma/*.cmr file)

* Tap ﬁor tap E’ and select Open CMA project to open a CMA Coach

Activity/Result or tap E and select Open to open any Activity/Result.
* The Open an Activity dialog opens. Browse and select the desired Activity/Result file

and tap @
To create a new Result (*.cmr file)

- Tap E or|E| and select New or New (Sound Only) if you want to collect data only
via the internal sound sensor.

After opening an Activity or Result, the Coach Toolbar changes. Each Activity or Result
has a few Screens, which are displayed after tapping its respective icon:

Icon Screen:
= Activity
< Sensors
r~ Diagrams
E Tables
Texts
@ not displayed in Results created on VinciLab and
in Activities/Results in which Texts are not included.
P Images
(&) Web-pages
EJ] Student Texts

* Tap anicon to display a respective screen.

* When the new screen appears it has a tab with two icons:
Screen icon - this icon now has a different function, it lists all items available in the
selected Screen, e.g. a list of Activities/Results, a list of connected sensors, a list of
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available diagrams, etc.
E’ - tap this icon to open the Tool menu with specific options.

In the bottom bar the following icons may be present:

Icon Tap this icon to:

Start the measurement
Grey when no sensor(s) connected/selected

@ Interrupt the measurement at any time
Appears after the measurement is started

Take a manual measurement
Appears in the manual measurement mode

Stop manual measurement
Appears in the manual measurement mode
@ Open the Measurement Settings

Go to the Home Screen

Tap "> to switch back to Coach

3. Typical measurement procedure in the Coach Application’

* Turn VinciLlab on by pressing its power button. Wait until the Home Screen appears.
* Ensure VincilLab has sufficient battery power or is connected to a power supply.

e On the Home Screen tap [ to open Coach.
* Connect the desired sensor(s) to the sensor input(s) of VincilLab.
* Open a new Coach Result:

= 1ap ] or Tap (¥ and select EIE ME X
NEW |f YOU onIy want to WOI"k Al : Pressure sensor 0..700 kPa
with the internal sound sensor
select New (Sound Only).

- A new Result opens and displays
the Activity Screen. a a

1. When a connected sensor is
detected and identified then
its name appears in the (%) AL: Pressure sensor 0.700 kPa (BTesi) (CMA) (EEPROM)
Activity Screen and its live
readings are displayed on the Sensors Screen.

16:09

I

> This procedure does not describe the Event-based type of measurement, use Tutorial ‘Event-based
measurement’ to learn how to perform this type of measurement.
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or

2. When a sensor is not SR
identified then it has to be ™A11a2 A3 a4/ D1lD2 /X|Y Z
manually selected from the Sensor: None
Sensor Library: go to Sensors

Screen, tap E and select

Sensor Settings, tap the

sensor input tab to which the Create New...| | Choose
sensor is connected, tap

Choose (or None) and select the desired sensor from the list.

Open a ready-to-go Coach Activity or Result:

Tap ﬁ or Tap Iil and select Open or Open CMA Project....

Browse to select the desired Activity/Result or tap and select the desired
Activity/Result from the list. Tutorials and examples of Activities are available in

the CMA Projects. Al : Sound sensor -45..45 Pa
€ OJ€ects Detected: Temperature sensor (0511) (CMA)
. . Connect the defined sensor or click the Exchange button.
Confirm with @ 9

The Activity/Result opens. Coach
automatically detects and

identifies the connected
sensor(s). If the identified sensor
is different from the sensor Exchange

defined in the Activity/Result

then the sensor listed on the Activity Screen is displayed in red. The sensor digital
display shows information about the sensor defined in the Activity (red) and the
sensor identified by VinciLab. Connect the defined sensor or change it into the
detected sensor by tapping Exchange. This feature is not available for sensors,
which cannot be identified.

Tap to display live readings of the connected sensors. The live displayed data are
not stored in VinciLab’s memory.
You are ready to start a measurement. The measurement will be executed according

to the given measurement settings. Tap @ Measurement Settings to check these
settings, modify if needed. Note that the max. sampling frequency is 1 MHz and the
max. number of collected measurement points is 50 000 per input.

Tap to start data collection.

In most cases, Coach directly starts the measurement.
If triggering is enabled then the measurement is started automatically when the
trigger conditions are met.

When the type of measurement is set to Manual then the Manual Start icon
appears in the bottom bar. Tap this icon to collect a single measurement. When
keyboard input is specified then the value of one or more quantities has to be
typed in the dialog, which will pop-up.
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* WARNING! When tapping

and starting a new data collection run, existing data is

overwritten by the new data without any warning. To avoid losing any data always

save your Result first.

* The measurement stops when the specified measurement time (time-based
measurement mode) or specified number of samples (manual measurement mode)

has been reached. If you want to interrupt the measurements process tap @
v .:I
* To save your result go to the , tap or tap |E| and select Save or Save As....

Note:

* To avoid loss of data, for instance in case of empty battery, the Coach Application will save
intermediate results during measurements longer than 10 minutes. Saving of the Result file,
will be done each minute (in case of new data). The last saved file can be found in

My Files/DataRecovery/last_result.cmr.

EYFEEREEE

4. Activity Screen

The Activity Screen gives an overview (in
the form of a tree) of all items available
in the opened Activity/Result. Each tree
branch corresponds to one of the Coach
Screens.

* Tap to go to the Activity Screen.

(x]

Sensors a
Al : Pressure sensor 0..700 kPa (BT66i) (CMA) (EEPROM)
Graphs
Pressure vs. Volume
Al : Pressure sensor (Standard)
Tables
Pressure vs. Volume
Al : Pressure sensor (Standard)
Texts
1.Activity description
2.Experiment procedure
Student Texts

1 Invectinatinne

® 07.Boyle's law.cma

BcH08 0 [+

v

16:23

* Tap a tree branch to show all available items or to close it. If there are no items

available then the branch is not shown.

* Tap, hold and release an item listed
under a branch to display this item in its
respective Screen. For example tap,
hold and release diagram ‘Al: Pressure
sensor (Standard)’ to open the Diagram
Screen and display the ‘Al: Pressure
sensor (Standard)’ diagram.

* Tap again to directly display the list
of activities present in the currently

Activities: @ E]
00.Physics Lab.cma -
01.Graphing distance.cma IMA) (EEPROM)
02.Match the graph.cma
03.Simple harmonic motion.cma

< 04.Newton's law of cooling.cma E]
05.Sound waves.cma Iﬁ
06a.Speed of sound - Echo time.cma
06b.Speed of sound - Traveling time.cma fﬁ
07.Boyle's law.cma
08.0hm's law.cma ¢EI
09.Electromagnetic induction.cma &cC
10.Discharging a capacitor.cma b
11.Half time of Barium137m.cma 10:30

opened folder. Tap an Activity/Result to open it.

* Tap El to display the Tool menu.
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ACTIVITY SCREEN ToOL MENU

- New - to open a new Result.

- New (Sound Only) - to open a new Result with the internal sound sensor.
- Open ... - to open a Coach Activity/Result.

- Open CMA Project... - to open a CMA Coach Activity/Result.

- Save ... - to save the existing Result.

- Save as ... - to name and save the existing Result.

- Delete ... - to delete a current Activity/Result (*.cma/*.cmr file).

- Activity Options - to set the Activity options.

- Close - to close the existing Activity/Result and return to the Main Screen.
- Quit Coach - to quit Coach Application.

At the right the following icons are present:

Icon Tap this icon to:

* Open a new Result
ﬁ Open an Activity/Result, see below
|u—l| Save the current Result

] -
¢|_ Close the current Activity/Result
—
&C Exit Coach

After you have chosen the Open option

the Open an Activity dialog is displayed.

In this dialog tap: CMA Coach Projects/en 3|
= Name Size Date
. to go one level up, 1.Tutorials

.-} 2.Exploring Biology
E 3.Exploring Chemistry
. to create a new folder(s), L1 4.Exploring Physics

. to open the folder with the CMA
Projects and Activities,

folder.
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5. Sensors Screen

The Sensors Screen is used to show live
data measured by the connected
sensor(s) and to set wup the
measurement and sensors.

A digital display appears automatically
when VincilLab identifies the sensor. For
a sensor, which is not identified, a
digital display will be created only after
selecting a sensor from the VincilLab
Sensor Library. The live sensor readings
are not stored in VinciLab’s memory.

* Tap to go to the Sensors Screen.

. Tap again and select a sensor to
one sensor is connected).

SENSORS SCREEN ToOL MENUS
Tap EI to display the tool menu:

ElRIGIEIEIEIRIE x]

Al : Temperature sensor -40..140 °C

22.7 °C

A2 : Pressure sensor 0..700 kPa

146.47 kPa

>y All sensors o 16:57

maximize its digital display (when more than

— Sensor Settings... —to open a dialog to define sensor settings.
— Measurement Settings — to open a dialog to define a measurement type and its

specific settings.

Touch, hold and release a sensor digital display to open the sensor Tool menu:
— Sensor Settings... —to open a dialog to with sensor settings.

— Set to Zero - to set the current measured value to zero.

— Set to Value - to set the current measured value to another value.

— Reset Calibration — to reset the Set to operation.

5.1. Sensor Settings

The Sensor Settings dialog displays the sensor information and allows sensor setup. The
dialog has tabs: Al, A2, A3, A4 - for analog sensor inputs, D1, D2 - for digital sensor
inputs, and X,Y,Z - for the internal 3-axis Accelerometer.

* Tap a tab e.g. Al to display the current
settings of the sensor connected to this

input.

As long as a sensor is not automatically
identified by Coach or manually selected
from the Sensor Library the Sensors Screen
remains empty and the Sensors Settings

dialog shows None behind the sensor.

Sensor Settings .

Al|A2 A3 |A4 D1ID2|X]|Y|Z]

Sensor:

None

‘Create New...‘ [ Choose
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A. Automatically recognized sensors
When the connected sensor s
identified its information appear in the
respective tab of the Sensor Settings
dialog.

B. NOT automatically recognized
sensors

When a connected sensor is not

identified (an older type of sensor or a

sensor whose EEPROM memory cannot

be read) then the sensor has to be set

up manually.

* Tap Choose or tap None.

* Tap the name of the desired sensor

to select it and confirm with

C. Own sensors

Users can create their own sensors and

add them for use in Coach. Since analog

inputs of VinciLab measure voltage

signals in two ranges, between 0 .. 5V

or-10.. 10V, it is important to indicate

which voltage range is used by a new

sensor.

* Tap Create New.

* Select the voltage range of your
New sensor.

Sensor Settings .
AL A2/ A3|A4/D1[D2/X|Y|Z]
Sensor: Pressure sensor (BT66i) (CMA)
Range: |0 .. 700 kPa (EEPROM) v |
Use as: \Analog sensor v |
| Settozero | |Set to value... Reset | Calibrate...
[ Replace... ]
Current value: 146.47 kPa
Choose a sensor from Library . °
CMA Library v
CMA: Switch (06253) (0..1)
CMA: Temperature sensor (016) (-18..110°C)
CMA: Temperature sensor (016i) (-18..110°C)
CMA: Temperature sensor (0511) (-25..150°C)
CMA: Temperature sensor (BT01) (-40..140°C)
CMA: Temperature sensor (BT84i) (-18..110°C)
CMA: Thermocouple sensor (0135i) (-200..1350°C)
CMA: Thermocouple sensor (0135i) (-20..110°C)
CMA: Thermocouple sensor (035) (-30..1400°C)
CMA: Thermocouple sensor (BT86i) (-200..1300°C) v
CMA: Tharmacain la cancar [RATQRIN [ DN 11N 5
Name Brand
Create/Edit a User-defined Sensor ‘ °
Sensor: J0 .. 5V range] |
Family: |Voltage v
Function ) Points Graph | Points
Quantity: |V Min: | 0.000] spyw;
Unit: v Max: | 5.000| .
Linear y=ax+b vl
a=| 1 b =| o |
1
Non-calibrated value:  0.007 V Vv
Calibrated value: 0.007 V ) B

* By default the sensor settings are filled like for a Voltage sensor. Enter the
sensor information adequate to your sensor.

* Perform the sensor calibration by providing a function or by typing/measuring
the calibration points in the same way as described for the standard calibration.

See below 5.2. Sensor Calibration.

* Tap

to save the new sensor. If you save it in the User Library then it will be

available globally and you can use it in any Coach Activity.

D. Built-in sensors

In the Sensor Settings dialog you can
also enable and disable the internal
Sensors.

Internal accelerometer

The X, Y, Z tabs in this dialog are used
for the acceleration components
respectively in x, y and y direction. Tap

To remove the user sensor tap Delete sensor.

Sensor Settings N '9
AL|A2[A3 A4 D1/D2 XY [Z]

Sensor: 3-Axis Accelerometer (X) (VinciLab) (CMA)
Range: -20 .. 20 m/s2 v |« Enabled

| Settozero | [Set to value... Reset Calibrate...
Current value: 0.31 m/s2
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X, Y, or Z and tap the checkbox Enabled to make the sensor ready for measurement.
Internal microphone

Tab A2 has additional button Enable Internal microphone, which switches this
output to measure via the Internal microphone. This allows using internal
microphone with combination with other sensors.°

The Activity Sound only allows to measure only with the internal microphone. It has
only tab Internal, which displays settings of the internal microphone.
Note that if an external microphone is connected via Audio In port then the internal
microphone is disconnected and the external microphone is used instead.

Options of the Sensor Settings dialog:

Sensor: displays the sensor’s name, number and brand.
Range: displays the sensor range, for sensors with the EEPROM memory this is the
range stored in the EEPROM (selected by default). Most sensors have more
measurement ranges.
* Tap a measurement range to choose another 0 .. 700 kPa
range. The calibration stored in the sensor’s [URAUYGER(SSENC))
memory is indicated by ‘EEPROM’. 0 .. 7000 hPa
Use as: displays the mode in which the sensor
works. Most sensors are used by default in the Counter
Analog mode. Digital sensor (1-bit)
* Tap the selected mode to choose another mode. ~ Frequency meter
* Specify the conversion settings for Counter, Time-interval meter
Digital sensor (1-bit), Frequency meter and Time-interval meter.

Use Set to zero or Set to value to shift the provided sensor calibration. Use Reset to
reset the Set to ... operation.

Use the Calibrate button to open the calibration, which belongs to the current selected
range and modify it if needed. The new calibration can be added as a new range or
when the EEPROM range is selected can be stored in the sensor’s memory.

Use Replace to choose another sensor from the Sensor Library and replace the
currently selected sensor. This action can be performed even when the automatically
identified sensor is selected, then its settings are overruled by settings of the new
selected sensor. Use Remove to remove such sensor from the input.

5.2. Sensor calibration

Most CMA sensors do not need to be calibrated. Their calibrations are provided by the
sensors themselves (stored in the sensor's EEPROM memory) and by the Coach software
(included in the CMA Sensor Library). For even better accuracy these calibrations can be
improved or new calibrations can be made and added as new sensor input ranges.

The sensor calibration in Coach provides the sensor name, its measurement range and

6 L .
Only for VincilLab’s purchased starting from February 2019
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the mathematical relation between the voltage values produced by the sensor (in most

cases) and the values of the physical quantity measured. There are two ways to perform

a calibration:

* By providing a calibration function: method Function.

* By providing calibration points in the calibration table: method Points (not possible
for the EEPROM memory). These points can be:

- measured, the sensor voltage value is measured and the value of the
corresponding quantity is typed. In this case the sensor has to be connected to
the active interface. Such a calibration is the most accurate calibration.

- Keyed in, both the sensor voltage value and the value of the corresponding
quantity are typed.

The best function fit, through the calibration points, is calculated according to the

least-squares method.

The calibration function will be then extrapolated to cover the whole range.

For sensors equipped with EEPROM memory it is also possible to replace the factory
calibration by a new calibration. This allows making an accurate calibration per physical
sensor. Next time such a sensor will be connected and detected its new calibration will
be used.

To add a new calibration (range) for a predefined sensor

* Connect a sensor or choose a sensor from the CMA Library.
* Select a range from the CMA Library but NOT EEPROM and User range.
* Tap Calibrate. The Calibration opens and shows the sensor name, calibration settings

and the calibration graph.
* |nthe Range ID enter the range name. Sensor: Pressure sensor (BT66i) (CMA) (0..700kPa)
) . . Range ID: my calibration
* Select the calibration method: Function . .
. ) . » 'Function Points Graph
or Points. When the method Points is ity 1 . 0.0] "o
selected the tab Points with the unit kPa Max: | 700.0]
calibration table is added. Linear y=ax+b |
. . . a= 171.04| b = -41.33
* If desired change: Quantity, Unit, N
Minimum and Maximum. Non-calibrated value: 0.838 V * VV)
H H : Calibrated value: 101.9 kPa 0
* Select the desired function-fit type.

* Perform the calibration. Key in the function coefficients (Function) or fill the
calibration table by adding calibration points (Points).

* Tap to save the new range. If you save it in the User Library then it will be
available globally and you can use it in any Coach Activity.
* Use the Delete range button In the Sensor Settings dialog to remove a user range.

To replace the calibration in the sensor’s EEPROM memory

* Connect a sensor equipped with EEPROM memory.

* Check if the range is set to EEPROM, if not tap the range and select the EEPROM
range (the word EEPROM is displayed in brackets).

* Tap Calibrate.

* Key in new coefficients and if needed a new unit. The calibration graph will be
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adjusted accordingly. It is not possible to edit quantity, minimum and maximum of
the sensor range and function type. This is because the EEPROM calibration has a
specific (fixed) format.

* You may use the Get from

Library button to load an existing Sensor: Pressure sensor (BT66i) (CMA) (0..700kPa)

calibration from CMA Sensor Library. Function Points Graph
Quantity: |p Min: | 0.00 i
* Tap to store the new calibration in unit: kPa Max: [ 700.00

the sensor memory. Tap OK to accept. ‘Unearﬁfg:gg 5 3‘
. . a= . =
The new calibration replaces the old
EEPROM calibration. Non-calibrated value: 0.839 V
. . i : 146.47 kP: ] 3
e Use the Reset Calibration to Factory C'°ratedvale i ,
L. [ Get from Library H Reset Calibration to Factory Settings \
button to restore the original EEPROM
calibration.

V(V)

To edit a self-defined sensor

* Choose a self-defined sensor from the User Library.
* Tap Edit. The Calibration dialog opens and shows the sensor name, calibration
settings and the calibration graph. If desired modify the calibration settings.

* Tap to accept. The sensor can be overwritten or added as a new self-defined
sensor.

5.3. Measurement Settings

The Measurement Settings dialog specifies

. . Measurement Settings FJ &
how Vincilab has to measure. Select the e
) Method | Triggering | Advanced |
measurement type (time-based, event-based .

] Type: Time-based v |
or manual) and set the respective Measuring time: | 10| seconds =
measurement settings. If you want to start | pequency: [ 50][per second =
your measurement automatically enable | number of samples: | 500/ (1 .. 500000)
triggering and define trigger conditions in the
Triggering tab. In the Advanced tab it is
possible to repeat the measurement process

a number of times.

6. Diagrams Screen

The Diagrams Screen is used to display measured or calculated data in diagrams. Here
you can also adjust graph settings, create new diagrams and perform data processing
and analysis.

A standard dlagram,.the sen:sor quantity / E]\
vs the clock (time), is created |
automatically after a sensor has been
identified or selected from the Sensor
Library. Changing of any diagram style
options, such as removing the grid or .
changing the diagram color, removes .,
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the suffix ‘(Standard)’ from the diagram’s name and makes it a user-defined diagram.

On starting a measurement graph(s) are drawn in pre-defined diagrams. Notice that
when starting a new measurement run, the existing data is overwritten by the new data
without warning. You can collect several measurement runs for comparison by using the
Copy column option from the Tool menu.

r
r
v

* Tap to go to the Diagrams Screen.

* Tap again to see all available diagrams and to select another diagram.

* Tap to open the Tool menu.

DIAGRAMS SCREEN TooL MENU

— Zoom to Fit (only for a diagram with data) - to optimally zoom in the graph.

— Zoom Out (only when in zoomed state) - to return to the previous zoom state.

— Scan (only for a diagram with data) - to read co-ordinates of points in the graph.
When scan is started use Stop Scan - to stop the scan.

— Erase all Values (only for a diagram with data) - to remove all data.

— Sketch - to draw a prediction graph or a graph, which can be converted to real
data. After the sketched graph is created use:
o Convert Sketch to Table - to convert the sketch to real data, or
o Erase Sketch - to remove the sketch.

— New Diagram... - to create a new diagram.

— Delete Diagram - to delete the displayed diagram.

— Graph Properties ... - to edit the displayed diagram.

— Graph Style - to change the display settings of the diagram.

— Import Background Graph - to import a graph with data from another Coach
Activity/Result and place as background graph.
o Shift Background graph — to move the background graph horizontally, use

Stop Shifting Background Graph when you are ready.

— Delete Background Graph - to delete the background graph.

— Process/Analyze - to select data processing and analysis tools.

— Copy column (only for a diagram with data) - to keep previous run(s) active.
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At the right the following icons are present:

Icon

Q
Q

7. Tables Screen

The Table Screen is

Tap this icon to:

Re-scale the horizontal and vertical axes to
optimally display the graphs

Return to the original scale. Active only after a zoom

Switch the grid on and off

Draw a prediction graph or a graph,
which can be converted to real data (toggle)

Stop drawing a sketch graph (toggle)

Change the display settings of the diagram

Scan - read co-ordinates of points in the graph (toggle)
(Active only for a diagram with data)

Stop scanning (toggle)

Go directly to the data processing and analysis tools

used to display &/E @\

x]

measured or calculated data in tables. time sound ‘ ‘
Here you can also manage table rows, ﬁ T
create new tables, import data from and 2 0.00 -0.26
export data to csv file and perform data > o S22 —
processing and analysis. 5 0.00 0.87 =
Tables are synchronized with diagrams ? 888 8‘3‘51’
and share a number of settings (among 8 0.00 -1.03
which their name): irrespective where = 0.00 11755
these settings are changed, they are © Teble1 14:00

reflected both in the diagram and the table. The standard table is the table
corresponding to the standard diagram.
On starting a measurement all table(s) are filled with data values. When starting a new
measurement run, the existing data is overwritten by the new data without any

warning.

* Tap to go to the Tables Screen.
* Tap again to see all available tables and to select another table.

* Tap to open the Tool menu.
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TABLE SCREEN TOOL MENU

— Erase all Values (only for a table with data) - to remove all data from the activity.
— Import Table - to import data from csv (text) file, after this action a new table

with data will be added.

— New Table... - to create a new table.

— Delete Table - to delete the displayed table.

— Edit Table ... - to edit the displayed table.

— Process/Analyze - to select data processing and analysis tools.

— Import CSV File - to import data from csv (text) file, after this action new columns
with data will be added to the existing table.

— Export CSV File — to export data into csv (text) file

— Data Rows - to add, delete and sort table rows.

— Edit - to edit table cells.

— Copy column (only for a table with data) - to keep previous run(s) active.

At the right the following icons are present:

Icon Tap this icon to:
Add a table row
_.)E(. Delete a table row
‘? Sort table rows
% Go directly to the data processing and analysis tools.

8. Texts Screen

The Texts Screen is used to display texts
that are prepared by Authors in the
Coach 7 program. Student users cannot
edit these texts. New Results created on
VinciLab do not include Texts Screen
since Student users can write and edit
only Student Texts.

* Tap to go to the Texts Screen.

* Tap again to see all available
texts and to select another text.

* Tap E to open the Tool menu.

TEXTS SCREEN TooL MENU
- Copy - to copy a piece of text.

BERYERCEE E x]

In this activity you are going to use a pressure sensor and a gas |4
syringe to study the relationship between gas pressure and
volume. Assume that at room temperature and atmospheric
pressure air behaves like an ideal gas. Because the air is closed

in the syringe the quantity of gas remains constant throughout

of the experiment. Your driving question is 'What is the
relationship between gas presure and volume when

temperature is kept constant?'.

In this experiment you will use:

- VinciLab,

- Pressure sensor - as default the CMA Pressure sensor (023i) is

used. The sensor is connected to input Al of VinciLab. v
@ 1.Activity description 14:17

- Text size - to select the font size used in (all) Texts.
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9. Images Screen

The Images Screen is used to display
photos and images (bmp, gif, jpg and
png files). By default there is no image
in a new Result created on VincilLab; the
Image Screen is empty.

* Tap to go to the Images Screen.

* Tap again to see all available
images and to select another image.

* Tap E’ to open the Tool menu.

IMAGES SCREEN TOOL MENU
- New Image - to add a new image.

BErFHERETE E

@ Experimental setup

EJ

14:17

- Delete Image - to delete the displayed image.

- Edit Title ... - to edit the title of the Image.

- 25% /50%/ 75% / 100% - to display the image in 25% / 50% / 75%/ 100 % of its
original size or to Fit it into the screen.

10. Web-pages Screen

The Web-pages Screen offers a simple
browser that can be used to add and to
browse to web pages. This browser
works only when VincilLab is connected
to a Wi-Fi network. By default there is
no web page in a new Result created on
VinciLab; the Web-pages Screen is
empty.

* Tap to go to the Web-pages
screen.

ElSiEIEERIGE

Google+ Search Images Maps Play YouTube Gmail Drive

Google

Google Search | I'm Feeling Lucky

Google offered in: Nederlands Frysk

@ goog|e U

PLLEBVNOD [

i
e
w
N

* Tap again to see all pre-defined web pages or to select a new pre-defined web

page.
* Tap to open the Tool menu.
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WEB PAGES TooL MENU

- New Web Page... - to add a new web page via http link.

- Delete Web Page - to delete a pre-defined web page.

- Edit Title ... - to edit the title of the pre-defined web page.

- Home Page — to set the displayed web page as the Home page (only one per

Activity/Result).

- Back —to return to the last viewed web page.
- Forward - to forward again to the viewed web page.

- Home - to return to the Home page.

- Refresh - to refresh a web page.
- Copy URL - to copy URL address.

At the right side of the Web-pages Screen the following shortcuts are available:

Icon

LLOOUVEOD

11. Student Texts Screen

The Student Texts Screen is used to
display texts, which can be edited by
student users. Student users can also
add their own texts. By default an
empty Student Text is included in a new
Result, allowing direct typing of student
notes.

. Tap to go to the Student Texts
Screen.

* Tap to see all available texts and
to select another text.

Tap this icon to:

To return to the last viewed web page
To forward again to the viewed web page
To return to the Home page
To refresh a Web page
To stop loading the current Web page (toggle)
To zoom in a Web page

To zoom out a Web page

BRYEFCEERE )

x]

1. Does a sine wave fit a sound waveform recorded for a tuning |&

fork? Fit a sine function to the data.

2. Calculate the frequency of the waveform.

The time period can be measured from peak to peak, you can
get a much more accurate measurement by tracing across five

or ten cycles and dividing.
3. Determine the amplitude of the sound wave.
4. Repeat the measurement for the second tuning fork.

5. Determine the frequency and the amplitude of the sound

dimem Lmn ke m mm e

@ 1.Investigations

v

14:40

* To type in notes tap the Text Screen, a virtual, on-screen keyboard appears. Enter
your text. Tap the key with the language code (e.g. EN for English) to select a

keyboard in another language.
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* Tap E to open the Tool menu.

TEXTS SCREEN ToOL MENU

- New Student Text... - to add a new Student text.

- Delete Student Text - to add a new Student text.

- Edit Title... - to edit the title of the selected Student text.

- Cut - to cut a selection of text.

- Copy - to copy a selection of text.

- Paste - to paste a selection of text.

- Undo - to undo the last action.

- Text size - to select the font size used in (all) Students Texts.

12. Processing and analysis tools

Data collected in measurements can be processed and analyzed with the advanced data
processing tools of the Coach Application. These tools are available under the option
Process/Analyze in the Tool menu of the Diagrams and Tables Screens or via the
shortcut icons.

The Process/Analyze options all work in a similar way. After selecting an option a dialog
that includes the data diagram is shown. Above and below the diagram the specific
parameters can be specified. The drop-down list located in the left upper corner is used
to select the quantity to be analyzed.

WARNING! To prevent data loss from a wrong processing save your data before starting
a processing tool.

12.1. Select/Remove Data

With the Select/Remove Data tool either a range of data or single points can be
selected for removal or retention.

To select/remove data

e Select Process/Analyze > Select
/Remove Data. X w | |Point-by-point v ‘

* In the top left drop-down list select the ' ‘
quantity for which you want to
select/remove data.

* In the next drop-down list select the
selection method. oo

* For the Range method: select the range
by dragging the boundary lines, or type
in the boundary values in the Begin and
End fields.

0.02

0.01!

-0.01
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For the Point-by-point method: select points by tapping a point in the graph or by

using the small icons: B0  olect all, bé deselect all, B0 colect even, OB colect odd,

select/deselect a point. Use — and + buttons to accurate select points.

Tap to confirm or ® to close the dialog without changes.

In the next dialog select Keep selected or Delete selected and confirm with

12.2. Smooth

The Smooth tool is used to create a smooth curve that fits a rough or limited set of
measured points. The smoothed graph may consist of (much) more points than the
original data set and can successively be processed.

To execute smoothing

Select Process/Analyze > Smooth.

In the top left drop-down list select the

graph you want to smooth.

In the next drop-down list select the

smooth method.
Specify the smoothing parameters:

- For Moving average enter the desired

Filter width.

- For Spline leave the automatically

X + | Spline e ‘

x (m)

H N W A U O N ®©

0 0.2 0.4 0.6 0.8 1.0

Quantity: Smoothed x| o4 7.13794E-7 @‘

calculated Smoothing factor or tap the # icon and type in the desired value.
If desired, change the name of the Quantity.

Tap to create the smoothed graph. If you are not satisfied with the result,

change parameter settings and tap again.

Tap to confirm or @ to close the dialog without changes.
Choose between Add graph, Replace graph, New graph or Replace data and

confirm with

12.3. Derivative

The Derivative tool is used to produce a graph of the first or second derivative of the
original quantity.

To calculate a derivative graph

Select Process/Analyze > Derivative.

In the top left drop-down list select the
graph of which you want to calculate
the derivative.

In the next drop-down list select the
derivative order.

In the third drop-down list select the

v |w| order: |1st w |Differences @«
_\L\(V) dv/dtime (V/s) 0
4 2
N :
3. 4
3. 6
2.9 8
2.4 10
19 12
14
e
03 time (s)t-16 -
0 1 2 3 18 %
Quantity:  |dv/dtime | Unit: Vs (%)
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method of calculating the graph of the derivative (Differences or Smooth).

When desired, edit the Quantity and Unit.
Tap to calculate the derivative graph.

Tap to confirm or ® to close the dialog without changes.

Select either Add graph or New diagram and confirm with

12.4. Integral

The Integral tool is used to calculate the function (the primitive function) whose
derivative is equal to the displayed graph. Such an integral function can be determined
for a constant of integration.

To calculate an integral graph

Select Process/Analyze > Integral.

In the top left drop-down list select the
graph of which you want to calculate
the integral.

In the Initial value field type in the
constant of integration. This is the
value assigned to the quantity along
the vertical axis for x=0.

When desired, change the name of the
Quantity and/or Unit.

Tap to calculate the integral graph.

Flow

Flow (L/s)

1.0

0.5

© nitalvalue [ 3

Flow*time (L/s*s)

N[
LA

Quantity:

Flow*time| Unit:

Tap to confirm or ® to close the dialog without changes.

Select either Add graph or New diagram and confirm with

12.5. Slope

L/s*s

ORI

The Slope tool is used to determine the slope of the tangent at any point of a displayed
graph.

To determine a slope

Select Process/Analyze > Slope.

In the top left drop-down list select the
graph in which you want to determine
a slope.

The diagram in the dialog is in scan
mode. The co-ordinates of the scanned
point, indicated by the cross-hairs, are
displayed in the fields below the graph.
To find a slope manually tap the point
in which you want to determine the

\

« | Slope:

-5.464

time (s)

time:

1.737
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slope. Use — and + buttons to accurate select the point. A line appears in the
diagram. Rotate the line until it is positioned correctly along the graph.

* To find a slope automatically tap . Tap the point in which you want to determine
the slope, the slope is calculated and displayed in the graph.
* Read the value of the slope in the Slope field. You can copy the value of the slope to

the clipboard by tapping r:il

* Tap to close the dialog.

12.6. Area

The Area tool is used to determine an area between the displayed graph, the horizontal
axis and two boundary lines.

To determine an area

e Select Process/Analyze > Area.

* In the top left drop-down list select the v Area: -0.022178
graph from which you want to
determine an area.

* The diagram shows two boundary lines
between which the area is calculated. 0% .0
Drag the boundary lines to the required | |
position, or type the x-values for the
boundary lines in the Begin and End
fields. Use — and + buttons to accurate
place the boundary lines.

* Read the area displayed in the Area field. You can copy the value of the area to the

time (s)
0.2 0.4

B
[

Begin: —| -0.212|4| End: — -0.002 |+

clipboard by tapping r:il

* Tap to close the dialog.

12.7. Function Fit

The Function fit tool is a procedure to approximate the data in the graph with a
standard mathematical function. You can choose from a large number of function types.
The coefficients of the fit function are determined using a least-squares method. Fitting
can be done manually or automatically. = T o
p (Pa) [Pin at: time=5.5 ms, p=8.14 Pa

To determine a function fit

e Select Process/Analyze > Function Fit.
* In the top left drop-down list select the
guantity which data you want to fit.

* In the next drop-down list select the
function type that will be used.

b &5 AN o N N o o

[
S

O

a: 91217 |b:; 2.4092|c:  13587|d:| 0.0195
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To automatically determine the fit:

- tap @, Coach automatically estimates the best initial parameter values of the fit
function; in some cases this is already the optimal fit.

- tap to refine the suggested fit.

To manually determine the fit:

- When the pin “is opened” you can shift the fit-function around. Touch the fit-
function and move up/down and left/right.

- When the pin “is closed” you can shape the fit-function around the fixed
pinpoint. Tap the pin to close it, touch the fit-function and stretch up/down and
left/right.

- Repeat the above steps until a satisfying result is obtained.

Tap to confirm.
Select Add graph or Replace graph.

Tap to confirm or @ to close the dialog without changes.

12.8. Signal Analysis

The Signal Analysis tool is used to find the frequency spectrum of a periodical signal.
The resulting values are presented as amplitudes plotted versus the frequency.

To determine a frequency spectrum

Select Process/Analyze > Signal [Pressure lLinear prediction_v JlLnear i
Analysis. o ' '
In the top left drop-down list select the  °°
graph of which you want to calculate oo

the frequency spectrum. 04
In the next drop-down list select the , .
e : ane
method: Fourier transform or Linear L F(H2)
. . 1000 2000 3000 4000 5000 %
prediction.

Begin: 0.1347| End: [ 0.3089] Coef:[14 +] @‘
In the third drop-down list select Linear

or Logarithmic for the intensity scale along the y-axis.

The diagram shows two boundary lines between which the spectrum is calculated.
Drag the boundary lines to the required position, or type the x-values for the
boundary lines in the Begin and End fields.

For Linear Prediction enter the number of coefficients. This number determines the
maximum number of peaks (formants), which will be found in the spectrum.

Tap to display the frequency spectrum of the signal.

Tap to confirm.
Tap OK again to confirm creating a new diagram or Cancel to return to Signal
Analysis.
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12.9. Statistics

The Statistics tool displays statistical information about the diagram/table as a whole or
about a selection of data in the table.

To display statistics

time \
* For the whole data set: select Process/Analyze > Statistics. Number: 201 ‘a0
For a selection of data: with your finger drag a selection in Max:  3.80 4.976
. 4 Min: -0.20 0.011
the table and then select Process/Analyze > Statistics. Average:  1.80  0.603
.. . . . Sum: 721.80 241.927
* You can copy the statistics information to the clipboard by sumsqr 1836558 787460
) E ) ) s(n): 116 1.265
Tapping . Click to close the dialog. s(n-1): 116  1.266

12.10. Histogram

The histogram tool is used to create a statistical histogram - a graphical representation
of the data distribution. The range of the variable (column) is divided into equal size bins
for which the frequency of occurrence is counted. The height of the diagram bar is equal
to the frequency of occurrence within the bin.

To determine a histogram

* Select Process/Analyze > Histogram.
* In the top left drop-down list select the ,

. Rate «| Bins: — 14|+
column for which you want to create ™ nia _
the histogram. 7

* Specify the Lower and Upper boundary j
values. 4
1

* Type the number of bins (default 5) or

use — and + buttons to set the number B _
. Rate (Counts/min)
Of blnS. 600 700 800
. Tap to create a histogram. If you """ =) Ueeer: 0l (V)

are not satisfied with the result, change parameter settings and tap again.

Tap to confirm your histogram or ® to close the dialog without changes.
Tap OK again to confirm creating a new diagram or Cancel to return to Histogram.

Vincilab User’s Guide | 43



V. USING VINCILAB WITH A COMPUTER AND A TABLET

1. Connecting VincilLab via the USB cable

Before you start using VinciLab with a computer via the USB cable we recommend to
first install the latest version of the Coach 7 or Coach 7 Lite software on your computer.
In most cases the VincilLab installation is automatically executed the first time VinciLab is
connected to the USB port of the computer. After successful installation VincilLab is
shown under Network adapters (Windows)/Ethernet cards (MAC).

¥ Hardware RNDIS/Ethernet Gadget:
) ATA
4 -&¥ Network adapters Audio Type: uss
y ) Bluetooth BSD name: ens
....%¥ Intel(R) PRO/1000 MT Network Connection N Kextname:  AppleUSBECM.kext
: - Camera Location: /System/Library/Extensions/AppleUSBECM.kext
LY Vinci Card Reader Version: 5.0.0
— VinciLab Diagnostics MAC Address: 00:01:02:03:04:05
- ID: 4214
Y3 Ports (COM & LPT) Disc Burning Vendor 02 1317
Ethernet Cards
D Processors Fibre Channel
. FireWire
4% Sound, videc and game controllers Graphics/Displays
-4 System devices Hardware RAID
C . . Memory
-§ Universal Serial Bus controllers NVMExpress
PCI
Parallel SCSI
= Ewé‘é.QAacSook Air » Hardware > Ethernet Cards
Windows Device Manager Mac System Information

If the installation process is not successfully performed in Windows (VincilLab is marked

by yellow exclamation sign) then the driver has to be installed manually.

* Go to Control Panel and start Windows Device Manager.

* Under network adapters right-click VinciLab and select Update Driver Software.

* Select Browse my computer for driver software.

* Browse to Program Files (x86)\CMA\Coach7\Common\EthernetCableDriver
location’.

* Click Next. The driver software will be installed. After successful installation the
message Device driver software installed successfully will appear.

2. Problems communicating with VinciLab

If after correct installation of VinciLab on your computer you experience problems with
communication between Vincilab and computer and the Coach 7 program there can be
a couple reasons for this.

1. A computer firewall may cause communication problems (as well via USB as via Wi-
Fi). Make sure that the Coach executable (Coach7.exe) has permission to use the IP-
address of Vincilab, and ports 22 and 1111 — 1116 are opened. If connected through
USB, the VincilLab gets an IP-address in the range 169.254.200.1 — 169.254.200.255.
For a wireless connection, the address depends on your network configuration.
Please note that when using the USB cable, it may take a while before VinciLab gets
its final IP-address.

2. An anti-virus program can block communication between Coach 7 and Vincilab.

” During the Coach installation the USB VinciLab driver setup files are copied to your computer.
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Give Coach (Coach7.exe) permission for such communication.

3. VinciLab makes use of Microsoft RNDIS drivers, some older versions of the RNDIS
software may give problems on Windows computers. There is a hotfix available at:
http://support.microsoft.com/kb/2477042) for Windows 7, Vista Windows Server
2008 R2, Windows Vista or Windows Server 2008. After installation of the hotfix use
the Device Manager to uninstall the Vincilab driver while VinciLab remains
connected to the computer via the USB cable. Then disconnect the USB cable from
the computer and connect it again to use the new Microsoft RNDIS driver.

WARNING! Always restart VincilLab after a failed attempt to connect VinciLab in Coach or

after you change the hardware settings in Coach.

3. Transferring files between VinciLab and a computer

Transferring files between VinciLab and a computer are only possible via the USB
connection. To get access to the VinciLab’s user folder ‘My Files” in Windows Explorer
and Mac Finder, VincilLab needs to be first mounted as a network location.

To mount VincilLab

* Connect VinciLab to the computer via the provided USB cable.

* Please note that each time VincilLab is connected to a computer via its USB cable it
may take up to 2 minutes before VincilLab gets its final IP address. Be sure that you
have successfully installed VinciLab on your computer.

Windows

* Click the Windows Start button and select Programs.

* Then go to CMA Coach 7 >

(=
Utilities and select Mount VB 1 Gormpitiily B Searh camiaes »
VinciLab‘ Organize v System properties Uninstall or change a program Map network drive  Open Control Panel = 0 @
L. , . © Favorites “ 4 Hard Disk Drives (1)

b The V|nC|Lab S user f0|der My j!:“k‘“i;l Local Disk (C:)

Files’ appears in Windows | e R

Explorer u nder Network - Libraries <z lMy Files (\\169.254.200.1) (Z:)

- 1.48 GB free of 1.49 GB
Location. & pemerene - Other @
. . 1% Computer
* To disconnect the ‘My Files’ ]
&2 My Files 1254.2001) (Z:
folder go to CMA Coach 7 > | _
Utilities and select Unmount g RO Wk ORKGROP
o Proc: Intel(R) Core(TM) i3 CP...

Vincilab.
Mac
* Open Finder and select Go > Connect to oo Connect o Sarver

server (cmd K) Server Address:

smb://169.254.200.1 €]
| |

* Use as the Server Address:
smb://169.254.200.1 and click Connect.

* If the system asks for password select
Guest.

After mounting Vincilab files can be copied or

Favorite Servers:
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moved between the ‘My Files’ folder on VinciLab and the computer. The ‘My files’ folder
consists of some pre-defined folders:
Coach - the default folder used for storing user’s Coach Activities and Results files.

This is the default folder used in the Coach Application for saving User’s files.

Media - with folders Audio, Images, Video used for storing audio, images and video
files. Files from Images subfolder are by default displayed in the Images Application
and files from Audio and Video are by default displayed in the Media Player

Application.

WARNING! Be careful when deleting files or folders in the ‘My files’ folder and do not
remove the predefined folders ‘Coach’ and ‘Media’. Removing these folders may cause
some of VinciLab applications to not work properly.

4. Using VinciLab for data collection with computers and tablets

Coach 7 and Coach 7 Litel for both desktops and tablets support measurements with
VinciLab. During such measurement VincilLab stays connected to the computer/tablet

via
via

a USB cable or communicates wirelessly
Wi-Fi. The collected data are transferred

in real-time to the computer/tablet and the
course of the measurement can be followed
directly on the computer/tablet screen. The
VinciLlab screen is inactive and displays the
image shown here. The recorded data are not
stored in the VinciLab’s memory and should
be saved in the Coach 7 program.

4.1. Communication with Coach 7

9
G

The Coach 7 program running on the computer/tablet can communicate with VinciLab
via:

To select the connection for VinciLab communication

the USB port when VincilLab is connected via the provided USB cable (not possible
for iPad, Chromebook and some Android tablets), or

via Wi-Fi when devices are in the same network.

Start Coach 7 or Coach 7 Lite.

Click Q or select the menu option Tools >
Hardware Settings (Author mode only).

In the Hardware Settings dialog click VincilLab.
By default the connection is set to USB. To
change it to the wireless communication, under
Connection select Wi-Fi. Be sure that Wi-Fi and
Data Share are turned on on VincilLab®.

Type the IP Address of your VinciLab (provided

Hardware Settings
Interfaces: Settings:

Connection
Adam Equipment Balance

CLAB IP Address
CoachLab IIfll+

EuroLab

EuroSense

Internal Sound

Wilab

Help OK

8 on Vincilab go to Connections, the Wi-Fi and Data Share sliders should be set ON.

wi-Fi g

192.168.2.118

Cance!
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in Connections on VincilLab). Accept with OK.

4.2. Typical measurement procedure in Coach 7°

Turn VinciLab on by pressing its power button. Wait until the Home Screen appears.
Start Coach 7 (or Coach 7 Lite) on your computer/tablet.

If needed set the connection for VinciLab communication, see the previous chapter
4.1. Communication with Coach 7.

In Coach open an Activity/Result for measurement or create a new measurement
Activity/Result (Author mode only).

Connect sensor(s) to the sensor input(s) on VincilLab.

VinciLlab automatically detects the connected sensor(s) and displays the sensor icons
of the identified sensors on the VinciLab screen panel. The sensors, which are not
automatically identified, have to be selected from the Coach Sensor Library.

The measurement is executed according to the given measurement settings. Click

® to check these settings: measurement type, measuring time, sampling frequency
and number of collected samples. Notice that the max. sampling frequency is 1 MHz
and the max. number of collected measurement points is 500 000 per input.

Follow the instructions in the Activity or directly start the measurement by clicking

the Start button

- In most cases, Coach automatically starts the measurement.

- If triggering is enabled then the measurement is started automatically when the
trigger conditions are met.

- When the type of measurement is set to Manual then the Manual Start button

appears in the Toolbar. Click this button to collect a single measurement.
When keyboard input(s) is specified then the value of one or more quantities
have to be typed in.

I EEESHES EREEOvEvEyErEY O

Fisordeses RIEDGC] e el S
QEL o= 1

Name |+ time (ms) Pressure (Pa)

‘‘‘‘‘‘‘‘ R AL sensor e

-0.154 Pa

° This procedure does not describe the Event-based type of measurement.
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* The measurement is stopped when the specified measurement time (time-based) or
specified number of samples (manual) has been reached. If you want to interrupt the

measurements process, click the Stop button @or press <Esc>.

* Save your result via the File menu options Save or Save As.... The file will be saved in
cma?7/cmr7 format.
WARNING! Coach on VinciLab does not read cma7/cmr7 files. If you want to use your
Activity/Result on VincilLab you have to save the file via the menu option Save for
Molab/VincilLab.

4.3. Activities for VinciLab

The Coach 7 program or Coach 7 App offers more features than the Coach Application
on VinciLab. One of the most important is the Author mode with the possibility of
creating Coach Activities and Results for VinciLlab. Such Activities (*.cma files) and
Results (cmr.* files) can be copied to the VincilLab folder ‘My Files/Coach’ or a USB flash
memory and opened in the Coach Application on Vincilab.

Any features in the Activities/Results not existing in the Coach Application, such as
images embedded in texts, videos, diagram annotations, etc., will be ignored when
opened on VinciLab and will be not shown. Tutorials and examples of Activities are
available as well in the Coach Application as in the Coach 7 program.

5. Displaying VinciLab’s screen on a computer or a mobile device

VincilLab offers Data Share via Virtual Network Computing (VNC) which makes it possible
to monitor the VinciLab screen and to control VinciLab from any computer or a mobile
device, such as an iPad, an Android tablet, Chromebook, or a smart phone, connected to
the same network as VinciLab. The VNC protocol can run via a network connection but
also via a USB connection.

To display VinciLab’s screen via a network connection

* |Install a VNC Viewer program on your computer or mobile device. Such VNC viewer
programs are freely available for all platforms, e.g. TightVNC Software
(www.tightvnc.com) or VNC® Viewer (www.realvnc.com).

* Wi-Fi connection:

Make sure that VinciLab is connected to the same network as your computer or
mobile device. On VinciLab go to Connections > Data Share and allow data sharing
by dragging the Data Share slider to ON. VinciLab shows that VNC is running and
displays its IP address. Run the VNC client program on your computer or mobile
device and connect to VincilLab by using the IP address provided by VincilLab.

* USB connection:

Connect VincilLab to your computer or mobile device via the provided USB. Run the
VNC Viewer program on the device and connect to VinciLab by using an IP address
assigned to the USB port: 169.254.200.1.

* After connection between the two devices is successfully established the VincilLab’s
screen is shown in the VNC Viewer program. You can simply view the screen or
control it remotely.
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1. Key features

OPERATING SYSTEM
DispLAY

PROCESSORS

MEMORY
POWER
CONNECTIVITY

COMPUTER CONNECTION
USB PORT
OTHER PORTS

SENSOR INPUTS

BUILT-IN SENSORS

ADC RESOLUTION

SAMPLING FREQUENCY

SOFTWARE ON BOARD

SOFTWARE ON COMPUTER
(wiNDOWS, MAC)

SOFTWARE ON TABLET
(IPAD, ANDROID)

VI. TECHNICAL SPECIFICATIONS

Linux

5” (800 x 480 pixel) capacitive color touch screen

Main and Measurement processors
ARM Cortex A8 1000 MHz and DSP 120 MHz

8 GB, of which 5.5 GB user memory in the ‘My Files’ folder
Expandable with a USB flash drive

Rechargeable battery Li-ion 3.7 V, 4000 mAh

USB Power Adapter (100-240 V AC, DC 5V/2A)

Wi-Fi 802.11 b/g/n

Bluetooth® 4.1

Mini USB port also used for powering

Full USB for USB peripherals

Audio In: for external microphone

Audio Out: DC and AC voltage signals between -5 .. 5V (only on
Vincilabs sold starting February 2019)

4 analog BT (right-hand) inputs, each can work as a counter
2 digital BT (left-hand) inputs

Microphone, max. frequency 44 100 Hz

3-axis Accelerometer (+ 20 m/s?, = 40 m/s°, = 80 m/s?),
max. frequency 400 Hz

12 bits

Max. 1 MHz, 4 inputs simultaneously

Dedicated Desktop Applications

Coach Application for data collection, graphing and analysis
Coach 7 Lite (free)

Coach 7 (license needed), includes Author mode to create
Activities for VincilLab, and work with Data-Video, Modeling and
Animations

Coach 7 Lite (free)

Coach 7 (license needed), includes Author mode to create
Activities for VinciLab, and work with Data-Video and Modeling
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2. Working conditions and maintenance

For your safety and that of your equipment, follow these rules for handling, for cleaning

VincilLab, and for working more comfortably.

v’ Your Vincilab is designed to be operated on a desk or hand-held.

v’ Your VinciLab is not waterproof. Precautions must be taken to ensure that liquid
cannot enter the unit.

v" Do not expose VinciLab to extreme heat or cold sources and to direct sunlight for
extended periods of time.

v Operating VincilLab outside the following ranges may affect performance:

o Temperature: 5° to 40° C.
o Relative humidity: 0% to 90% (noncondensing)

v" Never force a connector into a port. When connecting a sensor, make sure that the
sensor cable connector matches the port, and that you have positioned the
connector correctly.

v" When cleaning Vincilab, first turn it off and unplug the connected sensors and USB
cable. Then clean with a soft, lint-free cloth. Avoid getting moisture in any openings.
Do not spray liquid directly on VinciLab.

v" When replacing the battery, only use a VinciLab replacement battery pack supplied
by CMA.

v" When charging the battery always use the provided USB power adapter.

3. Factory reset

To perform a factory reset of Vincilab:

* If VincilLab is on shut it down.

* Press and hold the power button until the recovery process starts by showing the
message ‘Preparing a factory data reset’.

* Follow the instructions displayed on VincilLab.

* DO NOT turn off the device during the recovery. The recovery process may take up
to 10 minutes.

4. Warranty

VinciLab is warranted to be free from defects in materials and workmanship for a period
of 24 months from the date of purchase provided that it has been used under normal
laboratory conditions. This warranty does not apply if VinciLab has been damaged by
accident or misuse.

The Vincilab battery is a consumable and is warranted to be free from defects in
materials and workmanship for a period of 12 months from the date of purchase.

The VincilLab screen is made of glass and could break if your device is dropped or if it
receives significant impact. Do not use Vincilab if its screen is broken or cracked as this
could cause injury too.
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WARRANTY DISCLAIMER: PROPER USE OF A TAP-SCREEN

P
(0]
(0]

5

6

lease note that a touch screen responds best to a light tap from the pad of your finger
r a special non-metallic stylus. Using excessive force or a metallic object when pressing
n the touch screen may damage the glass surface and void the warranty.

. Battery precautions

Do not place the battery in or near fire, on stoves or other high temperature
locations such as direct sunlight. Doing so may cause the battery to generate heat,
explode or ignite, or generate a toxic gas if placed in contact with fire.

In the event the battery leaks and the fluid gets into one's eye, do not rub the eye.
Rinse well with water and immediately seek medical care. If left untreated, the
battery fluid could cause damage to the eye.

Discard batteries according to local regulations.

. Safety Information

VincilLab is developed and produced in conformity with CE regulations.

T

his product shall be handed over to your local community waste collection point for

recycle of the products.

ce B
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This product is to be used for educational purposes only.
It is not appropriate for industrial, medical, research, or commercial applications.




